Contemporary Approach to Writing Non-Linear Online Learning Resources

Margaret Turner
University of the Sunshine Coast.
AUSTRALIA
mturner@usc.edu.au

Abstract

Many academics continue to approach the multi-path and multi-voiced capacity of the Internet’s networked nodal structure as if it were a book with pages and paragraphs and sentences that flow together in one direction to make a whole. A different approach to that of traditional writing, is required to make effective use of the distinctive communicative opportunities offered by networked media. Reconsidering the use of the familiar concept maps is one example. The mapped content can be transferred into table cells in a word processor document rather than into paragraphs. In this way the content author is guided into a non-linear jump-style of writing where meaningful connections are made in multiple directions; a style that is typical of networked media. The purpose of this paper is to provide an introduction to an alternative approach to developing content for learning resources.

Keywords

online presentation, non-linear writing, online learning design

This paper is intended for academics writing content for their own online learning resources and speaks to the impact the underlying structure of the medium has on the meaning making - specifically, the differences between the structure of a book: a communicative device of linear organization; and that of a multi-lineal networked screen-media presented over an electronic and distributed system. Such differences highlight the need to change our accumulated and unconscious processes, what McWilliam (2005) calls ‘deadly habits’ of the way we consider both writing and pedagogy.

It is the author’s intention to introduce a different way of writing all content (teaching and research) for networked media; a way more fit for screen presentation. This new way of writing allows academics to explore their own subject matter from a different perspective, a perspective in terms of teaching, that more readily reveals the multiple pathways along which discipline-specific meanings develop and, with regard to the discipline, may open the subject domain under scrutiny to previously unseen interpretation.

Knowledge is a topology (as in the relationships between elements linked together in a system) rather than a route (as in a path from one place to another), and while much effort has gone into print media to find ways to accommodate this multiplicity within a strictly linear format, networked media, which is itself a ‘system of elements linked together’, is able to perform the task more effectively. This work is informed by socio-constructivist ideas on teaching particularly Laurillard’s conversational framework (2002), but also Underhill (2006); and draws on published theories of information design by Edward Tufte, Brenda Laurel and Brenda Dervin. It introduces concept mapping as a tool for organising content for online presentation and ends with a demonstration of a recommended approach using a word processor to construct media-appropriate web pages.
The Problem

Many subject experts continue to prepare learning resources for online delivery as if networked media is structured in the same way as a print document (Gráinne & Fill, 2005; Selwyn, 2007). They offer learners a ‘flat’ body of text on screen that imitates the presentation of a paper document. But what is on screen is not a ‘page’ of text. It appears that a ‘page’ of text on screen is more difficult to make sense of than the same information presented on a printed page (Nielsen, 1997). Additionally, control of the resource and its unfolding remains with the academic expert and it cannot offer the opportunities that networked media can, for a student’s independent exploration (Bransford, Brown & Cocking, 2000). Linear content fails both to engage with the medium and, to use its unique expressive resources. It also fails to connect with the Net generation of learners. The Net generation has taken to the Internet, using it as the town square was once used, as their own place—meeting, conversing, playing, creating, politicking, working, all in together, the ‘liquid life’ as Zygmunt Bauman (2005) names it—and they expect more from learning resources online than what they are often given.

It is this author’s contention that the starting point for writing online media needs to acknowledgment and embrace the medium’s different structure, that is, distributed rather than linear; and for the content to be constructed and presented to take advantage of that difference. The structure of the Internet, as an example of this type of media, is an ephemeral network of distributed nodes in potentially continuous connection. In this network there is no centre, no beginning or end and no certain direction—just islands of stored information; hosted it is true, on real hardware housed in a multitude of real buildings across the world, but the Internet itself is not a ‘thing’, in the way a book is a thing.

Akin to Kenneth Burke’s ‘conversation of life’ (in Ross, 1999), the Internet arises out of connectedness and relationship, without beginning or end and has the potential always for growth. Information flows in many directions as does control, making the communicative connections robust. But it also embodies a kind of fragility, for if the ‘lights go out’, so too does the network and the conversation. This then is a description of the structure—distributed, connected, multi-directional, potential, open and ephemeral. What is needed in writing for networked media is a way of writing learning content that will clearly signal to participants the following characteristics of the medium:

1. That useful meaning can be developed following concepts that are distributed rather than presented together.
2. That there is no hard edge to a discipline, it spreads out to connect with other disciplines and the real world.
3. That concepts can be connected along multiple paths in diverse directions to reach similar meanings.
4. That there is never-ending potential for expansion, growth; more and more data to be connected and made available to the conversation.
5. That things change—information is updated, ideas are modified, links expire, data is moved.
6. That control of information is spread and all who connect are potentially stakeholders.

Information Design and How We Make Meaning

Communicating in ways that acknowledge the underlying structures of a system is an area of study shared in common with Edward Tufte (1983) a graphical form theorist; information designer, Brenda Dervin (1999); writer Jay Bolter (1991); and human-computer interface expert, Brenda Laurel (1993, 1990). They make clear that formal, human-conceived structures underlie the way communication, and therefore meaning, is created and that control of those meanings and their
uses is frequently in the hands of the few, making communication and meaning anything but free and natural. Of course, it does also need to be remembered that communication of meaning is not one-way and that individuals naturally make unique meanings of the world through their personal engagement with it.

In the 21st century, the so-called Information Age, it is not uncommon to hear Net citizens complain that there is ‘way too much’ information in their lives. Architect and graphic designer Richard Wurman notes that their distress is more likely caused by poorly designed information rather than too much of it. It is not ‘information overload’ from which we suffer, says Wurman, but ‘non-information overload’ (Wurman, R.S., in Tufte (1983, frontispiece)). In the area of statistical data, Edward Tufte has termed the statistical version of this non-information overload ‘chart junk’. Chart junk is the overloading of graphs and charts with visual information that has no relationship to its meaning.

These added visual effects confuse the brain, they require further mental work to de-code, make sense of and work out what is crucial and what is non-crucial information to lead to the making of the desired meanings (Tufte, 1983). The purpose of providing information as a diagram, i.e. a pie chart, is to assist a reader’s comprehension of data so they can consider its implications. Where good design will assist the author to think clearly and convey information with clarity and meaningful benefit to readers, bad design does the opposite: it produces obfuscation and distraction, it does not assist a reader to understand (Tufte, 1983). There is purpose in presentation design and that purpose is to assist the content to be communicated effectively with clarity. To do that with networked media requires engaging with the differences of the medium’s underlying structures.

In relation to the underlying structure of a book, Dervin (1999) points out that there is a commonly held assumption that information is somehow naturally occurring, that it just happens to be presented as it is, that meaning transcends the presentation. This ignores the evidence that information has always been designed by those who wish to control that meaning. For instance in ‘Writing Space’, Jay Bolter (1991) documents how the presentation of the first bible was used to control its interpretation and dissemination. It was written in Latin so only the educated few could read it and bibles were chained to lecterns in the Church, to prevent theft, yes, but also to prevent the bible from leaving the consecrated ground of received interpretation. Elizabeth Eisenstein theorises that the invention of the printing press and the mass availability of bibles in the vernacular was a potent factor in the emergence of the reformation (Eisenstein in Bolter, 1991).
Nor is the traditional academic lecture a ‘natural’ form. It is written according to a set of assumptions and conventions about teaching and about pedagogy — transmission from one expert to many students who are considered unknowing, passive receivers; that learning can be listened to with concentration over a period of between 1-2 hours; that it can be absorbed, understood, placed into long term memory and then recalled for use in real world tasks. In addition, these lectures are structured for presentation on yet further conventions, those that govern a printed book—an entity that is bound into a thing that can be held and controlled; that doesn’t change; that is linear in format with a beginning, middle and end; that meaning is revealed by following a particular path; that is complete in itself and separate from other like entities even though it carries references to them. A lecture’s structure is no more a naturally occurring phenomenon than is the Vietnam Veterans War Memorial.

Brenda Laurel (1993, 1990) writes extensively on structures of information and how these can assist communication of meaning and Nathan Shedroff (1994), taking Laurel’s work, cites the shape of the Vietnam Veteran’s War Memorial in Washington, designed by Maya Lin in 1982. The triangular shape of the huge sculpture is dictated by the data of the daily toll of American soldiers’ deaths in Vietnam. As the police action intensified, the daily numbers increased and thus also does the size of the sculpture wall on which the names of those dead are recorded. The numbers of deaths each day reached a peak after which, as the action wound down to withdrawal, the daily deaths began to decrease, and thus also does the height of the sculptural wall. The result is a g-shape which reveals an underlying and meaningful structure for the sculpture—an arrangement of names related to each other by the day on which these men and women died. This structure is charged with meaning. An alternative suggestion considered at the time of the awarding of the design prize listed the names in alphabetical order. Alphabetical order would not add this relational meaning to the data; it would have remained a list whose relationship was based on an external and unconnected linear order.

The linear organization of academic writing and its appropriateness for dealing with complex human information is also under question. Studies by Beaver and Luker (in Thickett & Newton, 2006) investigating the efficacy of pamphlet information to inform patients with serious illness, have shown that where text is written as a kind of substitute for verbal information it nearly always has a higher reading age than the patient is easily able to understand, and this lack of communication actually adds to the discomfort of patients with serious or life threatening illness. In other studies of communication of patient information by the medical profession, it has been found that presenting the vital information as a mind (or concept) map improves the retention of data by as much as 10 percent over that which is written, linear fashion, in a pamphlet (Farrand, Hussain, Hennessy, 2002, in Thickett & Newton, 2006). In learning too, concept maps play a useful role. Novak and Gowin (1984) show that students are assisted to think and understand by the use of concept maps.

Translating these ideas—Tufte’s ‘unnecessary information can seriously detract from communication’, Dervin’s ‘information is designed not naturally occurring’; Laurel’s demonstration of how structure itself communicates meaning; the medical profession’s discovery that concept mapped information is more easily understood than linear pamphlets—into effective and engaging content for online learning resources requires:-

1. Acknowledging that the communicative structure of networked media is different.
2. That this difference requires, even of writers, different communicative strategies.
3. That mapping information visually can assist comprehension.
A Mapping Strategy for Non-Linear Networked Writing

With the introduction to this paper of concept mapping and similar relational and integrative tools, the writer has it in mind to move the common perceptions of visual design as something that is primarily about pictures and which occurs after the event of composition, to an understanding that all writers are in fact designers, designers of communication. Where linear composition is the dominant mode, the complex characteristics of meaning making—multi-directionality for instance—are unable to be fully developed or easily demonstrated to learners. Online media by contrast partakes of a multi-path conversational environment and has the capacity to easily develop and show this complexity with a clarity that assists meaning-making.

A concept map is a visual exploration of the placement, relationships and connections between, in the case of a knowledge domain, theory and practice. All content can be seen simultaneously from the potential of complexity in the detail to the broad sweep of thematic groups at the meta level. Additionally, the mapping process reveals the experts’ own distillation of facts, relationships and understanding about the knowledge domain built during their learning experiences and their subsequent professional practice. With this visible, it becomes easier to construct paths for other learners so that they too can be guided to gain an understanding of the topology of the knowledge domain (LeBrecque, 1998); to see the connections with what they already know; to identify the deficits and to build discipline-appropriate expertise (Laurillard, 2002).

The advantage of a visualised relational map is its capacity to:

1. demonstrate the spread, location and association of material in all levels of the knowledge domain in one view;
2. demonstrate the currents within the discipline, the flows and counter-flows between the islands of content and the nature of the relationships that link it all together, and;
3. show the broad themes that structure a particular content.

There are many ways to perform concept mapping; it’s the process not the tool that is important. For publication clarity in this paper the author used PowerPoint. The advantage of the PowerPoint Draw tool is that it creates boxes for content that can be connected by directional arrows and these boxes of content can be dragged around stage to change their location in relationship to other boxes while retaining the connecting ties. PowerPoint also has other graphic tools such as colour to bring to the process, however it does take more time and software skill than freehand methods and the author acknowledges that a freehand mapping process has a fluidity and chance that is definitely absent from the PowerPoint process. PowerPoint does generate an electronic version of the process and the content which is useful. The author’s preference for the mapping process is, however, yellow sticky notes, a white board and coloured markers and it this method that is outlined below.

**Developing the concept map**

- First establish the required outcomes for the course of study and what the learners need to know by the end of the course.
- Next, identify key concepts and write them on to individual sticky notes and place on the white board.
- Move the notes around, as many times as necessary, to organise the content into clusters that generate the most appropriate meanings.
- With different coloured markers draw connecting paths and relationships between ideas, theories and practices, erasing and redrawing as needed.
Work until the content coalesces into from two to four themes that together form the appropriate narrative structure for the content (Figure 2).

This mapping process will take time particularly where this process is unfamiliar to the content writer. There is a need to first become familiar with the actual method of mapping before it yields best results (Inglis & Bayley, 2005).

Once these broad themes are established, the next step is to develop the brief descriptive overviews and titles, which will be key in providing participants with sufficient information to make meaningful decisions with regard to their learning journey within the resource. Students will potentially visit the resource many times, it is known that they scan and don’t read (Nielsen, 1997) and they need to be able to quickly assess each time what they already know, what are their deficits and how they can move through it to accomplish the day’s goal and the overall goal. These descriptive introductions need to rise from fresh analysis of each cluster’s content because it is very easy for experts to assume knowledge of what they know so well and to miss key aspects that have emerged from the process.

Accordingly the descriptive process starts at the cluster level with surveying individual sticky notepapers and summarizing them in a brief and descriptive paragraph. From each paragraph, synthesise a very brief, two to three word, descriptive cluster title. The title is designed to reveal in an eye scan what the cluster contains, just as the brief introductory description can be scanned to reveal to the reader more of the type of information they will encounter if they enter that link. From these cluster descriptions develop an overall description of the clusters as a global introduction to the resource, and from that a descriptive title. The word descriptive is emphasised as the goal is to give decision-making power, as far as is possible, to the participant.

Simultaneous with development of concept clusters are the paths between them. These aspects of discipline knowledge are made more visible by the mapping process than the same ideas expressed in a page of text. The visual map accommodates more readily the reality that within a knowledge domain multiple paths to an answer can exist. Use colour to indicate which paths join similar concepts, and different colours to show how those paths that are linked, but in different ways. Beside each path describe the nature of the relationship or connection. Use arrows to indicate in which direction the relationship flows or an arrow each end if they flow back and forth (Figure 2). The figure below is developed in PowerPoint with the draw tool. It is taken from a mapping of the content area that forms one of the research foci of the author. This paper is drawn from the cluster ‘Communication and Meaning Making’, specifically ‘Strategies’.

The benefits of this mapping process are at least two fold. It assists the author to see at a glance the scope of the learning content in the resource, find the main learning paths in the content and their alternatives and it will also bring into the author’s focus the underlying structures of the discipline knowledge which in turn will assist in clarity in writing the content of the resource.
Writing Content for Online Presentation

With the content mapped and described, the next process is to place the content into a presentation format that is suited to the networked medium and translates as best as possible, the complex information in the mapping. A traditional document generated in a word-processor with paragraphs of discursive text will not do this. Presentation for networked media is about discrete screens of specific information presented in a direct, active style and connected via embedded links to other nodes. This direct style of writing is comparable to dialogue in a movie script—it is staccato in feel, with short sentences, often just fragments, and sentences that do not end with a full stop but an ellipsis indicating that more information is available if a link is clicked. A word processor, such as MSWord, can be used for this translation process, but it is used in a non-standard way, with changes made to the orientation, type face and layout so that the presentation better suits the medium. Documents are then saved from the word processing program as a web page.

Five major changes in traditional writing habits

1. **Orientation** The first change a writer should make to habits of writing acquired in a word processing program, is to change the orientation of the document to landscape from portrait. A computer screen is wide rather than long in contrast to the more usual portrait presentation of paper. Changing the orientation gives the writer a spread of space to develop the narratives of content in ways different to a long space.
2. **Font** The second change is the change of font face from Times to Arial. Arial is what is known as a sans-serif font face and san-serif fonts are easier to read on screen particularly at smaller sizes. When type was developed for the printing press in the 15th century, the model was ornate and mirrored cursive hand writing. The serif is a small decorative flourish abstracted from cursive script to refer readers back to the origins of glyphs in handwriting, which of course also refers back to the original preciousness and authority that the bible was, and is, afforded (Bolter, 1991). Serifs are not rendered well on screen because the resolution of a screen is coarse (72dpi) as compared to printed pages (300dpi).

3. **Layout** The third change of writing method is to insert a table into the landscape document, with as many cells as there are major clusters of content in the mapping. A table assists the writer to translate the mapped information on to screen without losing the relationships and paths.

4. **Control to the user** The fourth change is not technical but conceptual. The networked medium has expanded immediate connective capacity for which a writer needs to develop an attitude of giving control over to the participants (Laurillard, 2002; Osberg, 1997). There is still scope for persuasive argument in the way web content is written, but there is also the opportunity to provide alternative paths and connections to the wider world for the participant to develop a robust and still appropriate understanding of the knowledge domain of the content.

5. **Multiple entry points** The last major changes relates to a second conceptual change. Treat every page developed in an online resource as potentially a home page with comprehensive titling and navigation. Search engines insert users directly into lower level pages from off-site rather than through the official entry and they need to know where they are and where they can go.

**Translating Map to Web: The Method**

1. **Set up document**

   This document forms the entry node or top level of a learning resource.

   Open a new word processing document.

   From Page Setup, change the orientation from portrait to landscape.

   From the Table menu, insert a 3x3 cell table.

2. **Add top level content**

   Type the resource title and description into the middle cell.

   Type the cluster titles and descriptions into the outer cells.

3. **Add links to subsequent nodes**

   Make links to secondary levels as indicated in mapping.

   Highlight a cluster title e.g. ‘Communicating and Meaning making’

   From the Insert menu, insert a Hyperlink.

   Type name of the link in the hyperlink dialogue box.

   Note: This subsequent document does not yet exist but its link can be named, e.g. for the cluster ‘Communicating and Meaning making’ the link name is called ‘communication.htm’.
4. Save for web as index.htm.

From the **File** menu, choose **Web Page Preview** to see the document as it will look in a browser.

Figure 3a is an example of steps 1, 2 and 3 above as it would appear in the word processing document window. Figure 3b is an example of how the same document appears in a browser.

<table>
<thead>
<tr>
<th>Structures of networked media</th>
<th>Communication and meaning making</th>
<th>Grammars for meaning-making</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure Shapes Meaning And grammar</td>
<td>Structure shapes meaning of content</td>
<td>New grammatical devices needed for networked media</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>University of the Sunshine Coast</th>
<th>Writing for Networked Learning</th>
<th>Transitional movement</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADN217: Emedia C</td>
<td>New meaning structures, new writing methods, new grammars, new expressive devices.</td>
<td>Animation plays important role</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Learning paths</th>
<th>Theories of Learning</th>
<th>Navigation &amp; Context</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shaped by Discipline, theory &amp; needs of learner</td>
<td>Effective Learning requires Communication &amp; constructed meanings</td>
<td>Navigation shaped by Media structure and Learning needs of content</td>
</tr>
</tbody>
</table>

**Figure 3a:** Table used to translate the information from the concept mapping process into a word processing document without losing the qualities of the map.

**Figure 3b:** The table made in a word processor, saved for the web and viewed as a web page in a browser. This node or page forms the entry level of the resource.
4. Second Levels

Create a new document, align horizontal, insert a table and save for web as e.g. ‘communication.htm’.

From the concept map locate the names of the strands of content that lead off from the entry description of the cluster—in the above map, cluster ‘Communication’, these strands are ‘Theories’ and ‘Strategies’.

Type the title of the cluster and the titles of each strand in the table. In adjacent cells place the next level of content as indicated in the concept map. Add descriptive introductions both for the cluster as a whole and for the two strands (Figure 4a).

<table>
<thead>
<tr>
<th>Communication and Meaning Making</th>
<th>Theorists</th>
<th>Dervin &amp; Bolter,</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to this cluster</td>
<td></td>
<td>Tufte Laurel</td>
</tr>
<tr>
<td>Strategies</td>
<td>Intro to this strand</td>
<td>Tables in Word</td>
</tr>
<tr>
<td>Concept maps</td>
<td>Screens of content</td>
<td></td>
</tr>
<tr>
<td>Brief active descriptive writing</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 4a: A second table translates mapped information into second level of learning resource about ‘Writing for Networked Learning’ in the ‘Communications and Meaning Making’ cluster.
Third and subsequent levels

The individual notepapers of content generated in the mapping process above are each potentially a screen of content.

Make new word processor documents as above for each notepaper of content.

Use the table to distribute the information across the screen in ways that map connections and directions to proceed.

Insert hyperlinks to subsequent pages.

Figure 5a&b below demonstrate this process.
A writer continues to write the content into separate word processor documents, moving out from the clusters titles in the top level document. Technically this resource does not end in the way a linear paper ends with a conclusion. There will be many conclusions and paths and suggested further exploration, but not an ending.
Context

In figure 4b colour has been added to help separate the content—the colour relates to that used in the concept map to identify this cluster. Colour helps create a context that echoes the previous node or page and signals there is difference. Notice too that the colour is used in tertiary or muted forms rather than full saturation so that it sits back and allows the content to be foregrounded. Likewise the background of the page has been set at a neutral grey. White in a background is not only tiring for the eyes but also grabs attention from the content. Colour is added in Word via the Format menu, Borders and Shading and Background. Always use muted colours that do not grab attention from the content.

Conclusion

This paper has been written for the individual academic, to show how to generate simple and networked media appropriate web pages or nodes of content in a word processing document using tables for layout. All that is required is a willingness to take an approach to compositional form that is visually different to traditional academic writing. The suggested approach draws on contemporary theories of information design about how the differences in structure between a book and networked screen-media require different organisational structures and that the organisational shape of content can positively affect its communicative meaning. In order to find the most effective structure in which to present the content on screen, the content is first mapped with a visualisation tool. This mapping reveals not only the potential scope of the content but also the broad themes that form the structure. The suggested method of writing can be applied to all communication for online delivery, not just learning resources and is just one suggestion for the way forward to full networked media communication which fully engages the potential of the new medium.

References


Copyright © 2007 Margaret Turner